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Tutorial — Cables

Introduction

SCIA Engineer allows you to model a structure with cables.

First, we will discuss the theoretical background.

Next, we will explain how to model and load a chandelier structure.

Finally, we will run the (nonlinear) analysis and evaluate some results.

The figure below shows the model of the structure that we will design.

ay
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Since SCIA Engineer version 21.1, cables are fully supported in the 64-bit version in the default post-
processing environment. For cable analysis the module sens.03 is necessary. This module is included in the
Expert and Ultimate edition.

A cable element is an element without bending stiffness (ly and 1z 00). During the solving of the equations
this behavior is taken into account, so only axial forces (in tension only) will occur and you will obtain zero
values for the internal forces Mx, My, Mz, Vy and V:. The displacements (in the intermediate nodes) have thus
been calculated without bending stiffness.

The cable type is a special type of a beam nonlinearity, which can be applied on 1D members in a model.

You will need to create nonlinear combinations to take into account this nonlinear property during the
analysis. A geometrical nonlinear analysis should be executed by calculating with a 3 order analysis with
the Newton-Raphson calculation method.

A curve formed by a hanging cable is called a "Catenary". With relatively small bending (height - sag roughly
10% of its length) the curve can be approximated by a parabola (this approach was implemented previously
in the 32-bit version of SCIA Engineer in the post-processing environment ‘vi6 and older’), but such
approximation however becomes imprecise with greater sag / length ratio (and for different heights of the begin
and end nodes of the cable).

The catenary curve is linearly approximated into a polyline. The approximation points (nodes) are calculated
from the catenary equation defined by two edge points of the beam and its parameter a, which is defined as a
quotient (normal force / cable weight per unit length). The normal force is defined via the nonlinearity
parameters and the cable weight per unit length is calculated from the cross-section and material parameters.
Formula of the general catenary equation:

x —k
y=a-cosh( 3 )+c

Parameters k and c represent the horizontal and vertical shifts of the curve, respectively.

The relation between catenary length s, vertical span of two definition points v and their horizontal span His:

s2—vy2 = 2-a-sinh(£)
2a
You have full control of the catenary curve approximation precision. A general curvature approach has been
utilized. Using the curvature (parameter defining how much the curve bends at the given point) the radius of
the circles (of the same curvature as the curve in the touching point) is calculated. Concept of the
approximation error is graphically described in the figure below:

The detailed background (including formula to calculate the value of sag) can be found on our help-pages:
https://help.scia.net/webhelplatest/en/#analysis/nonlinear_analysis/cables/cable.htm
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Tutorial — Cables

Chapter 2: Modelli |

In the Project settings dialog, activate the Concrete and Steel material.
Project data >

Basic data Functionality Actions Unit5et Protection

| DATA | MATERIAL

Name: - i Concrete
Material C25/30 v ..
Part: - Reinforcement m ¥ o

| Description: - oizel
Material $235 v ...

Author: - | Masonry

Aluminium

Rate:. = Timber

Steel fibre concre

Structure: ! GeneralX1Z v | cooE

Mational Code:
B = v [=]

Mational annex:

B sterceraen v [

ok ||| cancet

On the Functionality tab activate the Nonlinearity and Cables functionalities:

Project data X

Basicdata Functionality Actions UnitSet Protection

| GENERAL | DETAILED
Property modifiers 4 Monlinearity
Model modifiers Beam local nonlinearity
Parametric input Support nonlinearity/basic soil <
| Climatic loads Initial imperfections
| Mokile loads Geometrical nonlinearity
Dynamics General plasticity
| Stability Compression-only 2D members
I Nonlinearity E I Cables E
Structural model | Friction support/Scil spring
IFC properties Memkbrane elements
Prestressing I Subsoil
Bridge design P Steel
Construction stages P Concrete
B Composite
ok || Cancel

Note that for cable analysis the module sens.03 is necessary. This module is included in the Expert and
Ultimate edition.

When the Cables functionality is turned on, automatically the functionality Geometrical nonlinearity is
turned on as well.
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21. Cross-sections
Go to Menu bar > Libraries > Cross sections (or with the icon in the workstation Structure).

Add a rectangular concrete cross-section of 400 x 300 mm for the circular ring at the bottom of the
chandelier. Add a circular shape or polygon of diameter 30 mm for the cable elements.

B Cross-Sections >
HiRGFE. «a~> O @ A v Y
C51 - Rectangle (40... Mame €51 A
52 - Polygon (30, 8] Type Rectangle
Detailed 400; 300
Shape type Thick-walled
4 Parameters
Material C25/30
H [mm] 400
B [mm] 340
4 General
MNeze calaao- Marmal calour v ¥
]
B 300
Mew Insert Edit Delete Setup | Update all | Close

2.2. Geometry

You can open the Marking menu by holding the Alt button together with the right mouse click. In the
subgroup Model you can choose to add a 1D member:

¥
A
A

1D Member Q
[ 'E/ ? H

PRES
8

MODEL

Draw the ring as two circular arcs with cross-section CS1.
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Tutorial — Cables

Then you can use the Marking menu again to add 8 Column elements with cross-section CS2 and length
12 m. For modelling the elements you can use the snapping option Line divisions:

Lc1-setfweight~ | ]

MagnetSnapping @ (O
Tracking Guides 37 (0 ) =
orthe = (O )
Lnegrid ¥4 OO
Dotgrid 1 (O ) =
Endpoints/ Nodes (\f‘?
Midpoints / Centers & @)
intersections I, @Y
Normal & Tangent 4= @Y)
Lnedivisions { @Y
Repeat 4 B
pointsonline N, (O )

Then select the top nodes of the column elements. Change the X and Y coordinate of these nodes to 0 m via
the property panel or via the input table (Main menu > Tools > Input table):

s - B B W N e

= o~ @ o B W N e

ﬁ Structure A

Z[m]
12,000
12,000
12,000
12,000
12,000
12,000
12,000
12,000

f&ﬁ Structure

INPUT TABLE

4 Name t X[m] ¥ [m]
N9 -5,000 0,000
il 3,536 [ 3,536
MNi2 0,000 5,000
W14 3,536 3,536
MN15 5,000 0,000
MN1T 3,536 -3,536
M18 0,000 -5,000
W20 -3,536 -3,536
H ¥ @& 4T B R
INPUT TABLE

4 Name 1 X[m] ¥ [m]
N3 0,000 0,000
N1l 0,000 0,000
MN1Z 0,000 . 0,000
N1id 0,000 0,000
N5 0,000 0,000
N1T 0,000 0,000
N18 0,000 0,000
MN20 0,000 0,000
H ¥ e LT HEI

Z[m]
12,000
12,000
12,000
12,000
12,000
12,000
12,000
12,000

A

- E—

Member

[ mpebere

Member

Bll

B12
Bl3
Bl4
BI5
Blé
B17
B18

2D member

2D member

E«,. E‘ L Y @ Y

B om X

BV —2024/06/20



Run the Check structure command to eliminate the duplicate nodes at the top:

Check of structure data X

CHECK OF NODES

I ———

Search duplicate nodes Ignore parameters
¥
CHECK OF MEMBERS -
EACheckm| Result of check of nodes
Search null L
These oroblems have been found with nodes:

Search dup

Members with undefined nodes: 0

Free nodes 0 S

Duplicate nodes: 7 04 Correct it
CHECK OF D nodes Bcopects

|| Nodes not in slab: 0 I

4 Check da

Incorrect coord. 0
CHECK OF A Do vou want to correct it?
Check a 0%

OK Cancel
2 Check fr L—
0
0%
Check load panels Check cross-links
Check additional data Check duplicity of names

Now we have already following structure:
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Tutorial — Cables

2.3. Boundary conditions
You can use the marking menu again to quickly add a fixed support at the top.
1
= e
a

o g Support In Node
s
| b
4 =
MODEL

Now you can apply the Nonlinearity 1D property to the elements. You can search for it via the SCIA Spotlight
or find it via Input panel > workstation Structure > category Boundary conditions.

| Toriatc = INPUT PANEL
! o>
& structure
I t£ Nonlinearity 1D Q= | = Boundary conditions
=7 Structure.Modeldata.Sectiononbeam 0 All tags W
Non-prestressed reinforcement
ﬁf Nonlinear combinations NONLINEARITY 1D @ & A G p 7 ﬁ ﬂ * ]
IL Nonlinear functions T
Dis Define Result classes. A Result classi... =7 14 o 0 Q0

1L Toggle nonlinearity

Following parameters are available for the type cable:

¥ ' Beam nonlinearity *

Name BN1
Type Cable v
Mormal force [kN] 1.00
Self weight :},‘-“I yes
Pn [kN/m] 0.00
Direction of load Z ¥
Approximation error [m] 0.010

Maximum sag [m] 0.000

OK Cancel
*  Normal force [kN]: value of the pre-stressing axial force (positive)
« Self-weight: determines, whether the cable is subjected to self-weight
e Pn [kN/m]: specifies the value of the additional load (so other than self-weight)
» Direction of load: specifies the load direction (Pn and self-weight)

*  Approximation error [m]:determines the maximal allowed distance between point on the analytically
defined catenary curve and the projection of this point (in the direction of
load) on the linearly approximated polyline of the cable.

e Maximum sag [m] automatically calculated value, it is the maximal distance (in the direction of
load) between a node of the catenary curve and its projection on the straight
line connecting both ends of the cable

Set 1 kN as normal force, activate self-weight and set 0 kN/m as Pn.

When applying the nonlinearity to the elements automatically the geometry is deformed according to the
catenary curve which is calculated with the inputted parameters.
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Add an element with cross-section CS2 in the middle of two vertical elements.

Via the subgroup Modify of the Marking menu you can select the Multicopy command and copy the
horizontal element 8 times.

Multicopy *

MNumber of copies 8

Insert the very last copy Copy additional data
DISTANCE VECTOR HOW TO DEFINE THE DISTANCE ?
Define distance by cursor * between two copies
x 0.000 m from original to the last copy
HOW TO DEFINE THE ROTATION ?
v 0.000
* between two copies
z 100 m from original to the last copy
ROTATION ROTATION AROUND
53 0.00 deg ® current UCS
distance vector
ry 0.00 deg
rz as| deg

OK Cancel

Connect the new elements with the existing vertical elements. When you now would change the
nonlinearities (e.g. change the value of the normal force), it will have an effect on the elements with the
nonlinearity, but as well on the connected elements. Make sure to select all elements when executing the

command.
L tucrcblessan
E2Linect members/nodes| (7 oY

*— Connect members/nodes ’

|= Disconnect members/nodes

Restore default user configuration

7

1=

v

Define the load case. A load case ... Ctrl+L

Select all the new elements via the Expand selection function in the Property panel and add the Cable
nonlinearity as well to the elements (you can take the same settings as before).

4
= 1D MEMBER (1) A
A 8 I

Name B12

Layer Layerl “/ =

Type beam (80) ~

Analysis model  Standard
FEMtype standard “~
Cross-section  CS2 - Polvgon (30,9) »—

i Isolate selection

Subtract from selection
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Chapter 3: Loads and combinations |

Go to the load cases and create a new load case LC2:

8 Load cases
B ERFEE a2 O wB A
LC1 - Self weight Name LC2
L2 Description
Action type Permanent
Load group LG1
Load type Standard
Stage for composite a Final stage, long term
Actions
Delete all loads
Copy all loads to another loadcase
New Insert Edit Delete

>

R

Close

Via the subgroup Load of the Marking menu you can select the Point Load in Node command and add some

point loads of 1 kN to the structure:

B Point force in node

Name E
F Direction Z
Type Force

Angle [deg]
Walue - F[kN] -1.00
4 Geometry
System GCS

OK ' Cancel |

BV —2024/06/20
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Tutorial — Cables

Open the nonlinear combinations:

m @ [ NONLINEAR COMBINATIONS

B eI e 5

Y5

And create a nonlinear combination NC1 with load cases LC1 and LC2:

At

5 Nonlinear combinations X
HEEFE a2 O A vY
NC1 Name NC1
Description
Type Ultimate v
Stage for composit: lysism A i v
4 Contents of combination
LC1 - Self weight [-] 1.000
LC2 [] 1.000
New from combinati... New Insert Edit Delete Close

14
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Chapter 4: Analysis |

As the calculation model is completely ready, you now can start the calculation.

Use the Calculate button in the middle of the process wheel in the process toolbar to start the analysis (or
via Menu bar > Tools > Calculation & Mesh > Calculate).

e -
| CALCULATE

S(5) @ i 1= g
\

When starting the analysis, check that for the Mesh setup the Average number of 1D mesh elements on
straight 1D members (linear approximation between the nodes of the catenary curve) you have at least 5
mesh elements and in the Advanced solver settings Geometrical nonlinearity is set to 3" order (large
deformations). If there are problems with convergence, increase the values of Number of increments, or
Maximum iterations. Additionally, the Solver precision ratio or Solver robustness ratio might be altered
to have an influence on the convergence criteria as well. Select Nonlinear analysis and press Calculate.

B FE analysis x
4 Mesh setup

Calculations
I Average number of 10 mesh element: 5 I

Linear analysis

Average size of 1D mesh element on ¢ 0,200
Load cases: 2

Average size of 2D mesh element [m] 1,000

Monlinear analysis
Connect members/nodes

Monlinear combinations: 1

Setup for connection of structural ent
Other processes
P Advanced mesh settings

Save project after analysis 4 Solver setup

Specify load cases for linear calculati

Specify combinations for nonlinear c:
Specify combinations for linear stabil
Specify combinations for nonlinear st
4 Advanced solver settings
B General
I Effective width of plate ribs
4 MNonlinearity

Geometrical nonlinearity 3rd order {large deformation) v

Methed of calculation Mewton-Raphson ¥
Number of increments 5
Maximum iterations 20
Solver precision ratio 1

Calculate Solver robustness ratic 1
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Tutorial — Cables

Chapter 5: Results

When the calculation is completed, results can be viewed. The relevant commands in the workstation
Results become active now.

Select the workstation Results in the process toolbar and click on the command 3D deformations.
&l 3D DEFORMATIONS

@) Eiri\iiﬁﬁ‘i @ F &
G

With the 3D deformations you can evaluate the behavior of the cables for the nonlinear combination NC1
and you will see that the cables go upwards. The graphical results look a bit strange because SCIA Engineer
presents the biggest deformation as 1 m:

a0

e

g

This makes sense for general structures, but for cables it's more convenient to look at the real ratio, which
can be edited via the Scale settings in the View bar. Set Scale type to Real ratio and Deformation [1:x] to
1.

wy OV 2 e .| B |
Scaleadddata 1 .._
Scaleresultdata 1 -._

I = Scale settings I
W1 Scales X
H-IBEHFE a2 @R A vy
Current Name Current n
“ Data
Scale type Automatic ratio v
Multiplier 1

+ Loads
Point loads [kN] 1.000
Line loads [kN/m] 1.500
Surface loads [k 2000
Temperature [K] 10.00
Translation [m] 0.010
Masses [kg] 1000.00
User defined AddDa 1
4 Result
| Scale bype Real ratio 7]
Multiplier 1
Reaction [kN] 5.000
| Deformation [1:x] 1 ]
Internal forces [kN] 5.000
Stress [MPa] 20.0
Contact stress [MPa] 20.0
Unity check results 1
Other results 10
4 Sumbale

New | Insert | Edit Close
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# SCIA 202005 handetier I

[ Peosectckhararpress [ fnesbelow:

DB X w@ © o

= 3D displacement
& Values: Utotal
3 Nonlinear calculation
2 NonLinear Combi: NCL
7 Selection: Al
Location: In nodes avg. on macro.
System: LCS mesh element

DK FFT

)
) @ " W w L
5

CL)

S

You can notice that the load straightens the curved elements.

Y

2710
200
200
200
80,0
1600
1400
1200
1000
00
800
@0
20

Utetd [mm]

oo m B e
Yea
RESULTS (1) A X
Name 3D displacement
~ SEiEcToN
Type of selection  All v
ter No %
v RESULT CASE

Typeofload  NonLinear Combi... \/

NonLinear Combi

NeL

wireframe (0

Location _In nodes avg. on ..
Valve U_total
SystemLCS mesh element
Exveme 10 _Global
Extreme20 Global

| ¥ CALCULATE RESULTS ON ..
10 members @D

2 positveface @Y
2D negativeface  @Y)

. L K 0 £

peformed structure @9
Member deformation _for global maxim...

For drawing use linear ... (O )

' ERRORS, WARNINGS AND NOTES SETTINGS
-«

Show Information abo....

Showerrors All v

Show warnings

All

Shownotes _In extremesonly
Show tablewith expla... @)
» ILLUSTRATION GROUP

ACTIONS 3
£ Refresh

® Drawing setup 30.
© Fesultstable
T Reportpreview

You can also have a look at the 1D internal forces such as normal forces N or bending moments My. Select
the workstation Results in the process toolbar and click on the command 1D internal forces.

1D INTERNAL FORCES
{
S e S A O I

& &

For these results you can put the Scale type back to Automatic ratio in the Scale settings.

Normal forces N:
@ SCIA 20205 Ganceter. I

[ Peosectckhararpress [ fnesbelow:

DB X w@ © o

= 1D internal forces

& Values: N

3 Nonlinear calculation

2 NonLinear Combi: NCL

7 Coordinate system: Principal
Extreme 10: Giobal

Selection: All
V]

[ A\
I+

\
B \Z
4 \H
<
=

g
I
7
2
th

PR e e B 8 W m & L

CL)
(] ﬂ%

!@E
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v ERRORS, WARNINGS AND

RESULTS (1)

o m B e

A X

Name 1D internal forces

v SELECTION
Type of selection
Fitter
Resultsin sections.
~ RESULT CASE

Al
No
All

Typeofload NonLinear Com... \/

NonLinear Combi
~ EXTREME 1D

Extreme 1D

Values

NCL

Global
N

nterval (3

~ DRAWING SETUP 1D
Display value name.
Display values

Display units

Display case

Display section dx
Display combination ...
Display combination .

®D)
«
-«
[eD)
(oD}
D)

lom)

Coordinatesystem Principal v

Colour scheme  Defined by result

Graphtype Filled light v

Envelopes drawing 0 to extreme. v
Label colour by graph @)

Drawing plane 3D v

Labelorientation  Perpendiculart... \/

'Show Information ab....
Show errors

-«
Al

» ILLUSTRATION GROUP.

ACTIONS 3
£ Refresh

| © Reiase

T Report preview

ES SETTINGS
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Tutorial — Cables

Bending moments My:

B SCIA 200205 Chandetier TN

DB Xwm@ o o A Please click here or press Space and type your text... t will be completed with fines below. v N =2 msSs B \ = E| S
g\l,l)‘ime:n”mcu m

3 Nonlinear calculation

2 Nonlinear Combi: NC1

£ Coordinate system: Principal
Extreme 10 Global
Selection: All

RESULTS (1) A X
Name 1D internal forces
~ SELECTION
Type of selection Al

it v
fitr No v
Resultsin sections  All v
v RESULT CASE

Typeofload NonLinear Com...
NonLinear Combi  NC1 v

v EXTREME 1D
Extreme 1D Global
Values M_y
interval D

T

Coordinate system  Principal v
v DRAWING SETUP 1D
Display value name
Display values

Display units.

Display case

D &S FF

Display section dx
Display combination .

8880880

Display combination....
Colour scheme  Defined by result

Graphtype Filled light v

[@EEREE!

Envelopes drawing 0 to extreme v
Label colour by graph @)

I Drawing plane 3D v

o=
Y

Label orientation Perpendicular t...
v ERRORS, WARNINGS AND NOTES SETTINGS.
show Information ab... @2
Showerrors Al v
» ILLUSTRATION GROUP.
ACTIONS

oK

P  Refresh Fs
)t @@ e e &g ae s L’E ® rlat
i

T Report preview

LR R

pa

il

&

@
&
L e

So in the cables, the only non-zero values of internal forces are for the normal forces N (tension). On the
second picture we can see that there are no bending forces present in the cables

Notes:

» The input of the cable element only defines the initial shape / sag. Afterwards the cable can be
loaded by real loads. The normal force after calculation will therefore be different to the inputted
initial normal force N.

» Adding a cable into the model will adapt the mesh also for the linear calculations. This means that
the linear calculation may become unstable when a cable is added, and a nonlinear calculation
becomes necessary to obtain results.
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